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МГТУ им. Н.Э. Баумана
ВВЕДЕНИЕ
Advanced Design System (ADS) фирмы Agilent Technologies представляет собой одну из самых мощных систем проектирования с расширенными возможностями, которая предлагает разработчикам передовые технологии моделирования. 
Система ADS содержит все функции, которые необходимы для разработки и проектирования аналоговых и цифровых радиотехнических устройств,  разработки всего сигнального тракта устройств, проводной или радиосвязи, включая разработку связных систем и цифровой обработки модулирующих сигналов, проектирование печатных плат, разработку монолитных интегральных схем, а также разработку пространственных электромагнитных структур и разводку печатных плат. Обладая уникальными свойствами, система ADS позволяет ее использование во многих областях техники, включая радио и лазерную технику.

Библиотеки элементов ADS содержат более 100 000 комплектующих изделий, а также средства разработки интегральных микросхем от ведущих производителей. Библиотеки проектирования ADS позволяют проводить разработки в соответствии с новейшими стандартами. Модели и методы моделирования, используемые в ADS, обладают высокой точностью и степенью достоверности.

ADS является средой, которая совмещает несколько эффективных технологий моделирования. Она позволяет определять или импортировать ВЧ, аналоговые и цифровые пара​метры, а также ключевые пара​метры взаимодействия моделей.

ADS предоставляет широкие возможности моделирования на системном, схемном и физическом уровнях с целью определения всех характеристик разрабатываемого изделия. Система ADS предлагает наиболее полный спектр технологий моделирования. При совместном использовании они позволяют полностью характеризовать и оптимизировать проектирование при множестве условий. 

Важным качеством системы ADS является простота проектирования, что непосредственно влияет на быстрейшее завершение разработки. Развитая архитектура системы ADS предоставляет разработчикам гибкость. Совместное моделирование в системе ADS позволяет объединять типы и области моделирования для анализа объединённой системы. 

Связь со средой Agilent VEE обеспечивает управление приборами, комплексное манипулирование данными и их совместное использование, а также автоматизацию настройки схем измерения, позволяя пользователю создавать технические решения под конкретные требования, необходимые для проверки его разработок.

На всех стадиях процесса разработки анализ подсоединённых сигналов позволяет использовать совместно реальные и полученные в результате моделирования сигналы, устройства и функциональные блоки. Варианты технических решений могут быть полностью исследованы без создания дорогостоящих макетов и проведения дополнительных этапов проектирования.
1. СРЕДА ПРОЕКТИРОВАНИЯ
Среда проектирования представляет собой набор окон, с которыми в данный момент работает пользователь. Все операции производятся внутри рабочей области текущего окна.
1.1. Основы интерфейса ADS
Главное окно имеет название Advanced Design System (Main) и содержит меню, набор инструментов для быстрого доступа к основным операциям. Необходимые данные представлены в виде дерева каталогов, где представлена иерархия текущего проекта.
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Рис. 1.1 Главное окно среды проектирования
Из главного окна возможно: создание и управление проектами верхнего уровня и схемами; установка набора необходимых пунктов меню; возможность конфигурирования панели инструментов и горячих клавиш; возможность выбора типов компонент, загружаемых во время запуска пакета; воспроизведение макросов, созданных с помощью встроенного языка (Application Extension Language - AEL); формирование AEL команд; запуск текстового редактора; открытие окна вывода результатов (Data Display Window) и др. 

Необходимо выбрать тип проекта перед тем, как начать работать с приложениями. Существует три типа проекта: Analog/RF, Digital Signal Processing или Both. Analog/RF определяет работу в подсистеме моделирования аналоговых устройств. Digital Signal Processing или Both задает работу в подсистеме проектирования цифровых устройств Ptolemy, тип Both используется для проектирования смешанных аналого-цифровых устройств. Уже созданный проект может работать только при совпадении текущего типа проекта с типом проекта, определенным при его создании. Можно изменить эти опции, используя пункт меню Tools>Advanced Design System Setup в главном окне, при этом необходимо перезагрузить систему.

С загрузкой ADS также открывается выпадающее окно проектов.
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Рис.1.2 Окно проектов
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  Рис.1.3  Главное меню и панель инструментов

Открыть справочное руководство можно, нажав пиктограмму Quick Start Manual, которая находится в окне Advanced Design System (окно  проектов) или в любом месте проектирования. Окно справочного руководства имеет вид:
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Рис. 1.4 Окно справочного руководства
Примеры  проектов можно открыть несколькими способами.

Первый способ - нажать на кнопку  
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, которая находится в главном окне Advanced Design System (окно  проектов). Откроется окно файлов с  примерами проектов 
[image: image90.png]B Data Display/Untitled B [page 1]:8
Fie Edt View Insert Marker Pege Options Tooks Hep

Selsl=] k] 0] 9f [@alale/d) 0] =]
mmm o vl B ]

Dy
@





[image: image5.png]Open Example Project

Ditectoies:
d\ads200dateramples

0 TV

3 AntennasFrop.
3 BehavioralModels
£ COMA

£ COMAK







Рис.1.5 Окно примеров проектов
   Второй способ - нажать пиктограмму 
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 , которая находится в окне Advanced Design System (Main). Откроется окно файлов с  примерами проектов:
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Рис. 1.6 Окно примеров проектов в главном окне
Чтобы открыть проект из примеров к программе Advanced Design System необходимо выбрать из списка интересующий проект и нажать на него двойным щелчком левой кнопки мыши. 

Для поиска файлов с  примерами проектов необходимо нажать пиктограмму 
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 в главном окне программы, откроется окно поиска  примеров проектов. Например, проведем поиск примеров проектов, в которых используется транзистор. Для этого нужно задать в окне Query(запрос) transistor и нажать на кнопку Search Now. В окне Results появятся все проекты, где используется транзистор. Окно Example Search имеет вид:
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Рис. 1.7 Окно более точного поиска примеров проектов
1.2. Окно схемного редактора
Окно схемного редактора имеет: заголовок, меню, кнопки инструментов, панель быстрого доступа к необходимым компонентам и область для проектирования схемы. В окне схемного редактора возможно создать и редактировать схему, задать переменные и уравнения, моделировать, открывать окно вывода результатов. В окне схемного редактора создается и редактируется схема проекта. Окно схемного редактора имеет вид:
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Рис. 1.8. Окно схемного редактора
Название проекта - показывает тип окна, тип проекта, имя файла и число - идентификатор, которое показывает какое по счету окно проекта загружено; Главное меню - отображает пункты меню, доступные в данном редакторе; Выпадающее меню компонентов  - позволяет  выбирать категорию компонентов, отображаемых в списке палитры. История компонентов - выпадающий список истории компонентов, содержащий компоненты, которые уже использованы в данном сеансе работы. 

Рабочая область - область, где располагается проект. 
Перечень компонентов - содержит кнопки компонентов для размещения их в рабочей области окна. 
Быстрые сообщения - сообщения о тех или иных командах, используемых в течение рабочего сеанса. 

Для открытия уже созданной схемы в меню File или File Brower нужно ее открыть. 
В окне схемного редактора  создается схема проекта.
Панель инструментов окна схемного редактора имеет вид:
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Рис.1.9. Панель инструментов окна схемного редактора


[image: image12.png]N

V==

[Lumped-Components





Рис.1.9. Панель инструментов окна схемного редактора
Кнопки панели инструментов окна схемного редактора:
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	Создание новой схемы
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	Открытие имеющейся схемы
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	Сохранение текущей схемы
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	Печать текущей схемы
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	Закончить команду и вернуться к выбранному режиму
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	Передвинуть объект
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	Копировать объект
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	Удалить
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	Вернуться на шаг обратно
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	Отменить  изменение точки входа
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	Увидеть всю схему
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	Масштабировать указанную область
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	Масштабировать  относительно указанной точки
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	Увеличить в 2 раза
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	Уменьшить в 2 раза

	
[image: image28.png]



	Крупный (панорамный) вид  указанного объекта
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	Развернуть иерархию объекта
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	Свернуть иерархию
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	Вращение объекта по часовой стрелке 
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	Зеркальное отображение объекта относительно оси “x”
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	Зеркальное отображение объекта относительно оси “y”
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	Деактивировать или активировать объект
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	Интеллектуальное моделирование
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	Вставить порт
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	Вставить землю
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	Вставит переменную величину
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	Показать библиотеку компонентов
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	Изменить параметры компонента
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	Вставить(соединить) провод
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	Вставить название провода
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	Моделирование (симуляция)

	
[image: image44.png]



	Настройка параметров
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	Новое окно отображения данных
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	Запустить сервис обработки данных из файла


 
Схема создается размещением компонентов, портов, источников данных, модулей, переменных и т.д. При запуске программы загружается набор библиотек и компонентов по умолчанию. Можно так же сконфигурировать загружаемые опции, и наиболее удобным способом здесь является выбор типов проекта при старте системы ADS.
Библиотека элементов открывается нажатием на кнопку Display Component Library List  
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, которая находится на панели инструментов.
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Рис. 1.10. Окно компонентов библиотеки ADS
 
Чтобы быстро находить модели компонентов нужно нажать на кнопку 
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Рис. 1.11. Окно быстрого нахождения компонента
Когда  модель компонента найдена, нужно  выделить ее в окне Components и нажать в нужное место схемы в рабочей области. Появится значок выбранного компонента и его модель. Проект создается размещением отдельных элементов в рабочей области окна. Для доступа к отдельным компонентам используется: Browsing - в окне библиотеки компонентов.  Searching - в окне библиотеки компонентов.  Component Palette - на левой стороне рабочего редактора. Сomponent History - в меню рабочего окна. 

Все эти средства позволяют размещать отдельные элементы в рабочей области (палитре) редактора. Для размещения отдельных элементов необходимо выбрать элемент и поместить его в рабочую область.

Возможно редактирование параметров компонентов, когда компонент включается в схему, и его параметры отображаются под его графическим обозначением. Значениями параметров могут быть арифметические выражения. Это особенно важно в иерархических проектах для передачи параметров компонентов верхнего уровня в компоненты нижнего уровня. Примером правильного выражения в качестве значения параметра является выражение x=pi/(2*order), где order - параметр, определённый для схемы или для символа верхнего уровня, а pi - встроенная константа. Основные арифметические операции - сложение (+), вычитание (-), умножение (*), деление (/) и возведение в степень (^). Эти операторы предназначены для работы с целыми и вещественными (с плавающей точкой) числами. В настоящее время все промежуточные вычисления выполняются с двойной точностью, и только по окончании вычислений результат преобразуется к типу того параметра, который вычислялся. Следовательно, необходимо соблюдать осторожность, когда, например, для вычисления целочисленного параметра используются выражения, оперирующие вещественными числами. В самом деле, для целочисленного параметра все промежуточные вычисления будут вычисляться с двойной точностью, после чего результат будет приведён к целочисленному значению.
1.3. Окно моделирования
Моделирование выполняется из окна схемного редактора. В рабочей области размещается необходимый  элемент контроля результатов моделирования в проекте, определяется имя для данных, которые будут сгенерированы при моделировании. Для аналоговых схем используются категории элементов контроля: Envelop Simulation и Transient Simulation  (для моделирования во временной области). Все данные, получаемые при моделировании, хранятся как Data Set - набор данных. Можно изменять имя до моделирования или оставить его по умолчанию, т.е. использовать имя текущего проекта с расширением .ds. 
Окно моделирования появляется во время моделирования проекта и запускается автоматически. Окно содержит две информационные панели: simulation/synthesis messages и status/summary. В первом окне соответственно отображаются сообщения об ошибках и проблемах, возникающих во время моделирования или синтеза, а так же причина, по которой возникла та или иная ошибка. Окно Status/Summary сообщает о ходе моделирования, выводит сообщение Simulation finished, если моделирование прошло успешно. 

[image: image51.png]Sinulation / Sunthesis Hessages

a3
Warning detected by HPEESOFSIN during IC analysis 'SP17,
Cireuit as given has no unique solution,
A wirtual resistance of 1 TOhns was edded to sach node.




А) Информационная панель сообщения об ошибках
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Б) Информационная панель хода моделирования.
Рис.1.12. Окно моделирования
Возможно деактивировать отдельные элементы в окне схемного редактора, исключая их из моделирования, без удаления их из проекта. Для этого нажать кнопку Deactivate на панели инструментов или выбрать пункт меню Edit>Component>Deactivate. Выбрать отдельный элемент или несколько элементов, которые необходимо деактивировать. Для обратной операции - активации деактивированных элементов используется команда Active из меню Edit>Item>Activate. 

1.4. Окно отображения результатов моделирования
Это инструментальное средство служит для просмотра результатов моделирования. Данные могут быть представлены в различных форматах, координатных сетках, возможно сохранить их в файлах и использовать затем в качестве шаблонов.

Открыть окно Data Display  можно из главного окна или из окна схемного редактора, выбрав Window>New Data display или нажатием соответствующей кнопки на панели инструментов.




Рис. 1.13. Окно отображения результатов моделирования
Строка-заголовок отображает тип окна, имя файла и числовой идентификатор. Существуют три команды для сохранения отображаемых данных: Save, Save As, Save As Template.  File>Save сохраняет изменения в текущем, существующем файле.  File>Save As сохраняет данные в файле с новым именем.  File>Save As Template сохраняет некоторую информацию из области рисования. Автоматически будет создан файл с расширением *.ddt, информацию из которого при необходимости можно вставлять в любое окно данных. 

Открытие существующего файла данных в окне Data Display возможно, выбрав Window>Open Data Display, указав имя файла и нажав Ok. Для закрытия окна Data Display выберите File>Close Window. Если данные в окне изменились, то вам будет предложено сохранить их.
Результаты моделирования, так же как и данные полученные от источников, сохраняются в специальном файле данных. Информация из этого файла может быть просмотрена в окне Data Display. 
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Рис. 1.14. Разные виды отображения результатов моделирования
В этом окне можно: отображать данные в виде различных графиков и в различных форматах; вставлять маркеры на графике для чтения данных в точке; записывать математические выражения, которые позволяют выполнять сложные операции над данными; добавлять комментарии и рисованные объекты для улучшения документации. 
2. ОСНОВНЫЕ ВИДЫ АНАЛИЗА ЛИНЕЙНЫХ И НЕЛИНЕЙНЫХ РАДИОТЕХНИЧЕСКИХ  УСТРОЙСТВ
В среде ADS поддерживаются следующие методы и виды анализов.

Анализ по постоянному току (Simulation-DC) - является начальным для всех остальных видов анализа, в процессе которого быстро проверяется топология устройства и проводится расчет рабочих точек схемы. 

Анализ по переменному току (Simulation-AC) - позволяет получить малосигнальные передаточные характеристики, такие как коэффициенты передачи по напряжению, по току, шумовые напряжения и токи. Этот вид анализа полезен при проектировании пассивных устройств класса А (например, малошумящих усилителей (LNA)). 

Анализ S-параметров (Simulation-S_Param) - позволяет определить линеаризованные S- и шумовые параметры, передаточные проводимости и импедансы. Кроме того, он может быть использован и для достижения многих других целей молосигнального частотного анализа. 
Анализ методом гармонического баланса (Simulation-HB) используется для расчета установившихся режимов в нелинейных устройствах в частотной области. Этот вид анализа весьма полезен при проектировании радиочастотных усилителей, смесителей и генераторов. Реализованный в данной системе метод подпространств Крылова позволяет существенно уменьшить требуемую память ЭВМ и увеличить скорость расчета по сравнению со стандартными подходами. Эта операция полезна при проектировании интегральных ВЧ схем большой размерности, когда проектируемое устройство включает в себя большое количество активных приборов и необходимо учесть много гармонических и интермодуляционных продуктов. 

Анализ большесигнальных S-параметров (Simulation-LSSP) производится на основании метода гармонического баланса и необходим для того, чтобы оценить значения этих параметров в нелинейных режимах мощных усилителей. Рассчитанные параметры могут быть использованы, например, в анализе на системном уровне. 

Анализ динамической характеристики (Simulation-XDB) позволяет пользователю эффективно определить точку сжатия передаточной характеристики (когда реальная нелинейная зависимость коэффициента передачи начинает отклоняться от идеализированной линейной), что очень важно при проектировании усилителей мощности.

Анализ методом огибающей (Simulation-Envelope) использует комбинацию анализов в частотной и временной областях, что позволяет эффективно проводить полный спектральный анализ сложных сигналов, таких как дискретно-модулированные ВЧ сигналы. Смысл анализа заключается в последовательном применении метода гармонического баланса для ряда временных точек по несущей частоте на некотором отрезке. Это полезно при проектировании схем и систем, включающих модуляторы / демодуляторы или работающих под воздействием сигналов со сложной модуляцией.

Анализ во временной области (Simulation-Transient) позволяет рассчитать параметры нелинейных устройств методами численного интегрирования нелинейных дифференциальных уравнений во временной области, когда элементы устройства моделируются приближенными эквивалентными схемами.


Рассмотрим подробнее два типа анализа радиотехнических устройств, наиболее часто используемые в практических задачах.

2.1. Анализ радиотехнических устройств по постоянному току
Для проведения анализа радиотехнической схемы по постоянному току необходимо выбрать из выпадающего меню компонентов в окне схемного редактора категорию DC Simulation.  В результате анализа по постоянному току возможно проанализировать характеристики радиотехнических устройств по постоянному току, что позволит определить потребляемую мощность схемы, получить передаточные вольтамперные характеристики, определить токи и напряжения в исследуемых точках. 

Анализ возможно проводить при  изменении значений источников токов и напряжений, а также других параметров схемы. При включении DC-анализа автоматически проводится анализ статического режима схемы.
В меню DC-Simulation  установить параметры (Рис. 1.15, 1.15а, 1.16, 1.17, 1.18)
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Рис.1.15. Вид окна Sweep в меню DC-Simulation
Sweep   установка изменяющихся  параметров. 
· Parameter to sweep – запись имени изменяющегося параметра.
· Parameter sweep – выбор разновидностей изменяемых типов и других параметров. 
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Рис.1.15а. Вид подокна Sweep Type
· Sweep Type
· Single Point – выбор фиксированного значения параметра. 

· Linear – выбор линейного закона изменения параметра. 

· Log – выбор логарифмического закона изменения параметра. 
· Start / Stop – выбор начального и конечного значений изменяемого параметра.
· Center / Span – выбор центрального значения параметра и отклонения при его изменении.
· Start – начальное значение параметра.
· Stop – конечное значение параметра.
· Step-size – размер шага изменения параметра.
· Num of pts – допустимое число точек, для которых проводится анализ.
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Рис.1.16. Вид окна Parameters в меню DC-Simulation
Parameters   устанавливает параметры, соответствующие сходимости, статусу и уровням отображаемой информации. 
· Convergence 
· Max.delta V – максимальное изменение узлового напряжения, допустимое на каждой итерации. По умолчанию принимается равным 0,1В. 

· Max.iterations – максимальное число итераций, допустимое при проведении анализа. 

· Mode – выбор алгоритма, по которому достигается сходимость: 

· Quick convergence test – использует результаты предварительных тестов, чтобы помочь предсказать какую комбинацию параметров сходимости нужно тестировать. При этом используется алгоритм Ньютона-Рафсона для различных величин допустимого шага (Max.delta V). 
· Robust convergence test – использует различные комбинации параметров сходимости (см. ниже).
· Newton-Raphson – итеративный процесс, прекращается, когда сумма электрических токов в каждом узле равна нулю для каждого узла и значения узловых напряжений  сходятся. Менее устойчив для средних и больших схем.
· Forward source – level sweep – при решении DC-Simulation устанавливает начальные значения напряжений всех DC-источников равными 0, заем  изменяя их значения до требуемых величин.
· Rshunt sweep – включает 1-омный резистор между каждым узлом и землей. Затем его значение меняется до бесконечной величины, соответствующей режиму холостого хода.
· Revers source – level sweep – используется достаточно редко. Значения источников напряжения меняются в обратном направлении. Позволяет учесть эффект отрицательного сопротивления в идеальных моделях генераторов, описываемых уравнениями Ван-дер Поля.
· Hybrid solver – использует возможности большинства из вышеперечисленных алгоритмов для обеспечения высокой скорости сходимости.
· Pseudo Transient – этот метод показывает хорошую сходимость при анализе больших интегральных схем.
· Levels данная опция позволяет выбрать уровень выводимой информации. 
· Status level – позволяет варьировать уровень выходной информации. 

· Device operating point level
Возможно  выбрать уровень выводимой информации о рассчитанных рабочих точках. Опция определяется в окне Simulate в главном меню при редактировании дополнительных опций анализа статического режима: 

· None – отсутствие выводимой информации. 

· Brief – вывод рабочих точек только для определенных пользователем активных приборов. 

· Detailed – вывод рабочих точек для всех активных приборов схемы. 

· Output solutions
1. Output solutions at all steps – установка DC-Simulation позволяет сохранять все получаемые решения в блоке данных, что может повышает сходимость решения при повторном анализе. 
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Рис.1.17. Вид окна Output в меню DC-Simulation
Output отображает выходные параметры.
· Save by hierarchy - запомнить иерархию 

· Maximum Depth – определенный уровень иерархии

· Node Voltages – эта опция позволяет вывести все данные в иерархическом проекте до определенного уровня;

· Measurement Equations – эта опция позволяет вывести все данные в иерархическом проекте до определенного уровня;

· Save by name – лист узлов и уравнений, явно указанных во вторичном диалоговом окне Add/Remove (добавить/удалить).
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Рис.1.18. Вид окна Display в меню DC-Simulation
Display   отображает параметры в окне схемного редактора. 

Используется для того, чтобы показать или скрыть все возможные параметры при моделировании: 

· Display parameters on schematic – опция позволяет выбрать те параметры, которые необходимо отразить на изображении схемы.
· Set All – показать все параметры.
· Clear All – скрыть все параметры.
Особенностью DC-анализа является то, что он  выполняется автоматически перед мало-сигнальным частотным анализом, анализом во временной области и анализом методом гармонического баланса. Поэтому при некорректном завершения DC-анализа (например, неверное соединение элементов, отсутствие сходимости), все перечисленные выше  виды анализов проводиться не будут. 

Линейные элементы замещаются их проводимостями на нулевой частоте. Конденсаторы, микро-полосковые разрывы, связанные линии рассматриваются как разомкнутые цепи. Индуктивности, проводящие нерегулярности рассматриваются как короткозамкнутые цепи. Линии передачи замещаются постоянными проводимостями, значения которых определяется их длиной. “Черные ящики”, представляемые файлами в виде S-параметров, должны иметь компоненты на нулевой частоте. 

Анализ статического режима проводится на основании итерационной процедуры. Модифицируя критерии сходимости, рассмотренные ранее можно регулировать точность и скорость расчета. Так можно увеличить максимальное число итераций. Если проводится анализ в диапазоне значений источников, то лучше всего уменьшать шаг их изменения, так как полученные на предыдущем шаге результаты используются в качестве начального приближения для следующей точки. Допускается также регулировать уровень ошибки расчета. 

Перед запуском DC-анализа автоматически проверяется топология схемы по следующим критериям, должно быть не  менее 2-х компонент соединенных в узле; DC-источники не должны быть  закорочены на землю; наличие петли из источников напряжения, тока, индуктивностей. Проверка не выявляет вышеуказанные дефекты в случаях с трансформаторами или линиями передачи. 

В случае обнаружения ошибок в топологии дефективные узлы подсвечиваются в Simulation / Synthesis Messages – окне. Для их идентификации нужно выбрать опцию Simulate>Highlight Node. Для обнаружения несоединенных линий или выводов элементов, нужно воспользоваться опцией Options>Check Representation>Unconnected pins. 

Если сходимость решения не удается получить за данное число итераций, то его можно увеличить следующим образом: в окне DC-анализа выбрать команду Parameters; Установить большее значение параметра Max.Iterations.

В случае анализа существенно нелинейных режимов алгоритмом по умолчанию и обнаружения несходимости, следует воспользоваться другими алгоритмами с помощью опции Parameters.
Другой подход к решению проблемы сходимости – установка больших значений параметров контроля сходимости с помощью опции Component Palette List>Options>Convergence>DC Convergence>Tolerances с использованием следующих команд: 

-
Voltage relative tolerance – относительная ошибка расчета узловых напряжений методом Ньютона на итерации (по умолчанию 10-6). 

-
Voltage absolute tolerance - абсолютная ошибка расчета узловых напряжений (по умолчанию 10-6В). 

-
Current relative tolerance - относительная ошибка определения токов ветвей (по умолчанию 10-6). 

-
Current absolute tolerance - абсолютная ошибка расчета токов (по умолчанию 10-6А). 

2.2. Анализ радиотехнических устройств  во временной области
Анализ во временной области позволяет моделировать переходные процессы с помощью контроллера переходных процессов. Контроллер  (Tran) моделирования переходных  процессов позволяет Вам определить следующие аспекты симуляции (Рис.1.19).
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Рис.1.19. Вид окна Time Setup, Integration, Convolution, Convergence, Options  в меню Simulation-Transient
· Установка временных параметров (Time Setup) устанавливает параметры, связанные со временем и частотой. 
· Интегрирование (Integration) выбирает метод интегрирования и диапазон изменения параметров, подключает шумы  источника и резистора, и устанавливает подгоняемые параметры прибора. Также доступны дополнительные варианты для анализа осцилляторов. 
· Свертка (Convolution) определяет параметры, относящиеся к установкам с использованием механизма сверток. 
· Сходимость (Convergence) устанавливает параметры, связанные с достижением сходимости. 
· Опции (Options) устанавливают параметры, связанные с имитацией, сообщая об уровнях полноты отчетов и сохраняемых  данных уровня  рабочей точки. 
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Рис.1.20. Вид окна Noise, Freq, Output, Display  в меню Simulation-Transient
· Шум (Noise)  устанавливает ширину полосы и масштаб для  шума.
· Частота (Freq)устанавливает параметры для основных частот, которые используются для того, чтобы вычислить начальное предположение для метода  баланса гармоник. Этот подход  называется методом анализа переходных процессов, усиленным методом баланса гармоник (Transient-Assisted Harmonic Balance, TAHB). 
· Выход (Output) в ADS выборочно сохраняются результаты симуляции в виде  набора данных. Для подробного изучения вопроса, обратитесь к теме "Выборочное сохранение и  управление данными симуляции»" в главе "Основы Симуляции" в документации Использование Моделирующих устройств Цепей (Using Circuit Simulators). 
В RFDE, используйте  Outputs > Save Option в окне среды разработки аналоговых схем (Analog Design Environment) . 

· Представление (Display) – управляет отображением параметров симуляции схемы. Для подробного изучения вопроса, обратитесь к теме " Представление Параметров Симуляции на схемотехническом уровне" в главе "Основы Симуляции" в документации Использование Моделирующих устройств Цепей (Using Circuit Simulators). 
3. ИССЛЕДОВАНИЕ ПРОЦЕССОВ АМПЛИТУДНОЙ МОДУЛЯЦИИ И ДЕТЕКТИРОВАНИЯ ЭЛЕКТРОМАГНИТНЫХ КОЛЕБАНИЙ В СРЕДЕ ADVANCED DESIGN SYSTEM
Цель работы – изучить физические процессы, происходящие в схемах амплитудной модуляции и детектирования амплитудно-модулированных сигналов, используя моделирование в среде ADS.
3.1. Основные теоретические положения
Модуляция и детектирование – это нелинейные электромагнитные процессы, которые сопровождаются преобразованием спектра частот входного колебания. 

Модуляция – это изменение одного из параметров высокочастотного колебания (амплитуды, частоты, фазы) по закону низкочастотного передаваемого сообщения. 

Цель модуляции состоит в переносе спектра низкочастотного сигнала в область высоких частот для передачи сигналов. Высокая частота, на которой осуществляется передача сигнала, называется несущей частотой. Частота изменения параметра высокочастотного колебания называется модулирующей частотой.

При амплитудной модуляции (АМ) по заданному закону изменяется амплитуда несущего колебания.

Аналитическое выражение АМ - сигнала можно записать как
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где:  
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 - амплитуда несущего колебания; 
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 - частота АМ – сигнала;
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 - модулирующая функция.
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 - коэффициент модуляции.

При гармонической модуляции АМ - сигнал можно записать в виде:
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Коэффициент модуляции можно определить: 
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где: 
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- соответственно максимальное и минимальное значение амплитуды высокочастотного колебания.

АМ -  колебание можно представить в графической форме (рис. 3.1.)
[image: image71.png]iy

10

0s.

00

10

ob o2 04 o8 o8 10 12

time, msec

s

18

15 20





Рис. 3.1. Временное представление АМ – колебания
АМ – колебание можно представить в виде суммы гармонических колебаний.
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Из выражения  видно, что АМ - колебание является суммой трех высокочастотных гармонических колебаний близких частот (т.к. ( << (o):
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Спектр АМ - колебаний приведен на рис.3.2. Ширина спектра равна удвоенной частоте модуляции: ((АМ = 2(. Амплитуда несущего колебания при модуляции не изменяется; амплитуды колебаний боковых частот (верхней и нижней) пропорциональны глубине модуляции. При m=1 амплитуды колебаний боковых частот достигают половины несущей. 
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Рис.3.2. Спектр АМ - колебания
Для осуществления амплитудной модуляции необходимо выполнить перемножение несущего и модулирующего колебаний (формула 3.2.). Амплитудную модуляцию можно получить, используя нелинейные цепи. 

Амплитудную модуляцию можно осуществить с помощью цепей, содержащих нелинейные элементы, ВАХ которых можно аппроксимировать квадратичной зависимостью (диоды, биполярные транзисторы, полевые транзисторы, лампы).

На практике в качестве нелинейных элементов модуляторов чаще всего используют не диоды, а транзисторы или лампы (триоды, пентоды). Модулируемое высокочастотное напряжение подают во входную цепь нелинейного элемента (в цепь базы, затвора, сетки). Модулирующий сигнал вводят в цепь различных электродов: в транзисторах - в цепь базы (затвора) или коллектора (стока); в электронных лампах чаще всего - в цепь управляющей сетки (сеточная модуляция) или анода (анодная модуляция). Коллекторная (анодная) модуляция обеспечивает более высокий КПД, чем базовая. Однако для ее осуществления требуется более мощный источник модулирующего сигнала. Отметим, что при малых уровнях входных сигналов для модуляции используется квадратичность входной характеристики прибора (как в диодных модуляторах).


Схема амплитудного модулятора с управлением по входу или базового модулятора на биполярном  транзисторе представлена на рис. 3.1.3. В этой схеме модулирующий низкочастотный и модулируемых высокочастотный сигналы подаются на базу транзистора. 
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Рис. 3.3. Схема амплитудного модулятора с управлением по входу
Под воздействием модулирующего сигнала напряжение  смещения на базе 
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 меняется с частотой модуляции (. Это приводит к тому, что импульсы коллекторного тока будут отличаться друг от друга высотой Imax и углом отсечки (. При подаче модулирующего сигнала u( амплитуда Imax и ширина ( импульсов тока меняются во времени, что приводит к изменению амплитуды первой гармоники Iк1 с низкой частотой (. Поэтому выходное напряжение получается модулированным по амплитуде. Выделение высокочастотного амплитудно-модулированного колебания осуществляется колебательным контуром, включенным в коллекторную цепь и настроенным на частоту несущей.
При осуществлении модуляции могут возникнуть искажения, заключающиеся в отклонении формы огибающей АМ - колебаний от формы модулирующего сигнала u(. Для получения неискаженной амплитудной модуляции требуется, чтобы амплитуда первой гармоники коллекторного тока Iк1 изменялась пропорционально изменению напряжения смещения. 

Модуляционную характеристика представляет собой зависимость амплитуды первой гармоники Iк1 от напряжения смещения Еб при постоянной амплитуде высокочастотного колебания U(. (Можно также строить зависимость амплитуды первой гармоники напряжения на контуре.) При работе на линейном участке модуляционной характеристики амплитудная модуляция осуществляется без нелинейных искажений.
Детектирование – процесс восстановления низкочастотного восстановления низкочастотного сигнала по модулированному высокочастотному колебанию. Детектирование считается неискаженным, если напряжение на выходе детектора повторяет закон изменения амплитуды модулированного колебания в случае АМ.


Поскольку в спектре модулированного колебания содержатся только высокочастотные компоненты (несущая и боковые частоты), а результатом детектирования является получение низкочастотных колебаний, для детектирования необходимы нелинейные цепи. Схема амплитудного детектора состоит из нелинейного преобразователя, в выходном токе которого при воздействии на вход гармонического напряжения 

 появляется постоянная составляющая и  фильтра нижних частот, предотвращающего прохождение на выход детектора высокочастотных составляющих. 
В качестве нелинейного элемента в детекторах наиболее часто используется полупроводниковый диод. Для выделения полезного низкочастотного сигнала последовательно с диодом включена RC-цепь. Для правильной работы схемы сопротивление R и конденсатор С должны удовлетворять следующим условиям:
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где 
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 - наивысшая частота в спектре модулирующего колебания.
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Рис.3.4. Амплитудный детектор
При детектировании, как и при модуляции, происходит преобразование спектра входного колебания. На выходе получается колебание с частотой, отсутствующей во входном колебании. Спектр выходного сигнала детектора представлен на рис. 3.5.
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Рис.3.5. Спектр сигнала на выходе амплитудного детектора
Основной характеристикой детектора является  характеристика детектирования, которая представляет зависимость постоянной составляющей выходного тока от амплитуды напряжения U. В зависимости от амплитуды входного сигнала детектор может иметь линейную или квадратичную характеристику детектирования. При больших сигналах (U > 0.5(1 В) диодный детектор имеет линейную характеристику детектирования, при малых сигналах (0 <U < 0.1(0.2 В) – квадратичную.
3.2. Задание и порядок выполнения работы

1. Создать проект, присвоив имя, например, modulyator_prj.
2. В среде ADS в  окне  схемного редактора подготовить схему (design)  макета амплитудного модулятора с  управлением по входу  и  амплитудного детектора с фильтром низких частот.
3. Проанализировать работу амплитудного модулятора с использованием ADS. Получить сигнал на выходе модулятора. Провести расчет модуляционной характеристики модулятора. Исследовать зависимость коэффициента модуляции от амплитуды модулирующего напряжения.
1. Проанализировать работу амплитудного детектора с использованием ADS. Получить сигнал на выходе детектора. Рассчитать характеристику детектирования амплитудного детектора.
3.3. Анализ работы амплитудного модулятора с амплитудным детектором

Для создания схемы в схемном редакторе ADS необходимо:

1.  Внести в схему транзистор ap_npn 2N3946, диод ap_dio 1N649, пользуясь библиотекой. Для этого нажать пиктограмму   Display Component  Library List.  Для быстрого нахождения транзистора или  диода нажать на кнопку  Find Component(s). В появившееся окно записать название прибора. Когда  модель компонента найдена, нужно выделить ее в окне Components и нажать в нужное место схемы в рабочей области. Появится значок выбранного компонента и его модель.
2. Разместить в окне схемного редактора пассивные элементы с сосредоточенными параметрами из группы Component Palette List > Lumped-Components. Выбрав значок нужного пассивного элемента (R, L, C ), перенести его в рабочую область. В окне параметров элементов задать их значения. 

3. Выбрать компоненту Component Palette List > Sources-TimeDomain>V_DC. Разместить  DC-источник на схеме в коллекторной цепи и присвоить требуемое значение (25 В). Разместить DC-источник на схеме в базовой цепи и присвоить требуемое значение (0.7 В).
4. Выбрать компоненту Component Palette List > Sources-TimeDomain>VtSine. Разместить VtSine-источники (V2 - Амплитуда 0.4 В, Частота 1 кГц), (V3 - Амплитуда 0.4 В, Частота 50 кГц) на схеме в базовой цепи и присвоить требуемые значения параметрам. 
5. Выбрать компоненту Component Palette List > Sources -Time Domain >I_DC. Разместить источник тока в базовой цепи и присвоить требуемое значение. 

6. Выбрать компоненту Component Palette List > Probe Components >I_Probe. Расположить амперметр между коллектором и  первичной обмоткой трансформатора. 
7. Соединить проводниками компоненты, размещенные в окне схемного редактора, с помощью команды Wire.
8. Присвоить имена тем узлам схемы, в которых необходимо определить напряжение, используя опцию меню схемного редактора Insert > Wire/Pin Lable или нажать пиктограмму Insert Wire/Pin Lable.
9. Все изолированные замкнутые контурные  цепи обязательно обеспечить соединением с «землей». Общий  вид скомпонованной схемы  представлен на рис. 3. 6.
10. Для проведения выполнения  анализа переходных  характеристик  выбрать контроллер анализа переходных процессов Component Palette List > Simulation > Transient > Tran  и задать временные параметры  анализа  в диалоговом  окне Time Setup: Start Time, Stop Time, Max Time Step, Min Time Step.
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Рис. 3.6.  Схема амплитудного модулятора и детектора  в  ADS
11. Запустить задание  на анализ командой главного меню Simulate > Simulate   или нажать кнопку Simulate меню инструментов.

12. В  окне моделирования отображается  процесс выполнения работы  активных контроллеров, оценка общего времени, затраченного на  симуляцию, общая оценка результата и сообщения об ошибках.
13. По завершении симуляции автоматически открывается новое или подготовленное ранее окно отображения результатов моделирования (данных). Форму  представления – таблица или график. Разновидность графика – прямоугольное окно можно выбрать в панели  графического представления.

Вид окна  отображения результатов моделирования амплитудного модулятора  и детектора  представлен на рис. 3.7.   
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Рис. 3.7. Вид окна  отображения результатов моделирования амплитудного модулятора  и детектора
14. Для  получения спектра  сигналов в окне просмотра  выходных данных надо разместить компоненту Eqn, описывающую вводимое  уравнение: spectr2=fs(V3,,,,,,,0ms,3ms). Здесь spectr2 -  имя  рассчитываемой спектральной характеристики ( назначается пользователем); fs – имя  библиотечной функции, реализующей Фурье-анализ, V3 -  имя  напряжения в  узле, для которого производится  вычисление спектра; 0ms, 3ms – начальное и  конечное значения временного интервала для Фурье-анализа. Можно сменить интервалы, не прибегая к  повторному  моделированию схемы. Из девяти аргументов функции fs() только один – имя  преобразуемой переменной, является обязательным. Значения необязательных переменных функции fs()  могут не подставляться, а их место отмечается  запятыми. Для получения детальной информации в окне Eqn  надо нажать кнопку «Functions Help».
15. Получение  модуляционной характеристики  модулятора   Ic1= f(Eб), где Eб = V1, а Ic1 - амплитуда первой гармоники выходного тока модулятора. Получив входной сигнал V3 и амплитудно-модулированный (АМ)  сигнал на выходе контура Vr,   использовать спектральное    представление АМ - сигнала на выходе     колебательного контура, полученное при подключении функции fs() (функция Фурье-преобразования) на этапе отображения данных.  Амплитуду  модулирующего колебания V2 задать равной нулю. Внести изменение V1 от 0.4В до 1.2В  c помощью VAR, DC, PARAMETER SWEEP моделирования.
16. Для  изменения  параметра в V_DC- источника необходимо внести окно схемного редактора контроллер описания переменной величины VAR. В окне свойств контроллера VAR  внести имя  переменной и ее начальное  значение. Внести в окно схемного редактора контроллер DC-анализа, в окне свойств DC- контроллера ввести  имя  изменяемой переменной  (Parameter to sweep), тип (линейный) и диапазон значений изменения параметра в соответствии с заданием.  Внести в окно схемного редактора контроллер изменения параметров PARAMETER SWEEP, в окне свойств  PARAMETER SWEEP - контроллера ввести  имя  изменяемой переменной  (Parameter sweep), тип (линейный) и диапазон значений изменения параметра в соответствии с заданием.  На  закладке Simulations ввести имена  контроллеров DC-анализа (DC1) и Transient-анализа (Tran1). 
17. Провести моделирование. Построить модуляционную характеристику как зависимость амплитуды первой гармоники выходного тока Ic1 от величины изменения напряжения смещения Eб на входе модулятора (V1) в окне отображения данных, используя результаты моделирования, полученные  в спектральной форме. 
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Рис. 3.8. Спектр выходного сигнала и модуляционная характеристика  амплитудного модулятора
18. Результат моделирования получить  в окне отображения данных на рис. 3.8. По модуляционной характеристике найти величину постоянного смещения Eб (V1), обеспечивающего модуляцию без искажений (середина линейного участка) и величину допустимого коэффициента модуляции m, при котором не происходит нелинейных искажений. 
19. Исследовать зависимости коэффициента модуляции m от амплитуды модулирующего напряжения (V2). Исследование проводить для напряжения смещения (V1), соответствующего середине линейного участка модуляционной характеристики. Модулирующий сигнал (амплитуда генератора V2) изменять в диапазоне 0.05 - 0.4 В.Измерение  коэффициента  модуляции   m  производить  по  спектральным компонентам выходного сигнала, снимаемого с колебательного контура. Амплитуда несущего колебания A1 =0.4В (V2).
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Рис.3.9. Зависимость коэффициента модуляции от амплитуды модулирующего напряжения
20. Получить характеристику детектирования как зависимость напряжения на выходе детектора Vd от амплитуды высокочастотного  сигнала Vr ( рис.3.10) .  Задать напряжение постоянного смещения на базе Eб (V1),  равным значению, соответствующему середине линейного участка модуляционной характеристики. Амплитуду  высокочастотного  сигнала изменять в пределах от 0.05В  до  0.4В. Определить линейный участок характеристики.
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Рис.3.10. Характеристика детектирования амплитудного детектора

3.4. Содержание отчета
1. Цель работы и задание.

2. Краткие сведения о методах анализа переходных процессов.

3. Графики зависимостей, расчетные параметры, полученные на каждом этапе выполнения задания.

4. Выводы по каждому пункту исследований.
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